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Introduction
Welcome to XL Guard, by XLforms.

Purpose
XL Guard is the application which allows you to easily ensure the security of your
workbooks and spreadsheets in a user-friendly interface. With our proprietary
User Access List (UAL) you can set access for up to 20 individual users to a single
workbook. This program is intended for personal or professional use.

This manual is intended to provide all the information needed to successfully
download and use the XL Guard application.

General Information
All XLforms products require Microsoft Excel desktop edition to function.

You will need a computer running Microsoft Windows 7, 8, or 10 operating
system with Microsoft Excel 2007, 2010, 2013, 2016, 2019 or 365 desktop editions
installed (please note that Excel Web & Mac editions are not supported).

We strongly recommend that you update Microsoft Windows and Microsoft
Office before installing any applications. XLforms applications only support
English (United States) at this time.

This application is not compatible with Apple/Mac devices at this time.
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Security Information & Requirements
In a world of ever-increasing computer security threats, we at XLforms find
ourselves challenged with seamlessly blending our code with Microsoft software
requirements, Antivirus software, and other related software demands.

Furthermore, it's our duty to inform our customers of such new requirements,
while at the same time making sure that our applications perform as advertised.

In this manual we will address all related security issues that have been reported
to us, and we will explain how to install and run our application while complying
with the latest industry demands.

Antivirus Security Notes

All XLforms applications include industry standard trusted signed certificates.

Antivirus software may hinder the installation of our product. If you get a
false-positive detection from the antivirus and if the application fails to install,
you will need to temporarily disable your antivirus software (see instructions
below) and then try to install again. Remember to reactivate your antivirus
upon successful installation.

To reduce antivirus false-positive detections, you may need to add our
application’s folder location and the folder path where you want to save
your future workbooks to the antivirus software’s exception list(see instructions
below).

Microsoft Excel Security Notes

XLforms' applications are developed for Microsoft Excel using Microsoft Visual
Basic for Applications (VBA) programming language.

As a result, it requires you to enable Excels' macros (see instructions below),
and preferably, add the path where you plan to save your macro enabled
workbooks to Excel's Trusted Locations list (see instructions below).



Back To Top
_____________________________________________________________________________________

PROTECT YOUR DATA FROM PRYING EYES 4

Set your Antivirus to run XLforms applications
In the example below, we are using Windows Security (Windows Defender)

Temporarily disable your Antivirus:

Open Windows Security (with Windows 10, you can type it in to the search bar).
Select Virus & threat protection.

Click Manage Settings (1).
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Under the Real-time protection section, click the On (2) switch
(assuming it's set to on) to pause real-time scanning.

Note: You may get a message "Do you want to allow this app to make changes
to your device?"   Select yes to continue.

The switch position should show Off (2)

Add XLforms application files to the Antivirus exception list:
While you are on the Manage settings page, scroll down to the
Exclusion section and click on Add or remove exclusions (3)
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Click on Add an exclusion (4) and then click on Folder (5).

Next, navigate to XLforms’ default applications folder location under
"C:\Programs Files (x86)" (6), select "XL Forms" (7) and then click on
Select Folder (8) button.

We recommend that you create a folder to store your safe Excels' macro
enabled files. For example: crate a new folder in c: drive and name it "My Safe
Excel Files". Next, repeat the above steps 4-8, and add the new folder path
"C:\My Safe Excel Files" to the antivirus folders exclusion list.

Remember to reactivate your antivirus upon successful installation!
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Set Microsoft Excel security

Turn on Excel's macro settings:

Open Excel, Click File > Options.
1. Select Trust Center from the left side options.
2. Click Trust Center Settings on the right side.
3. Select Macro Settings from the left options.
4. Select Disable all macros with notification on the right side.
5. Select Trust access to the VBA project object model on the right side.

Click OK to accept your new settings and continue with setting Trusted
Locations.
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Set Excel's Trusted Locations:

By default, new or unknown files are opened in Protected View by Excel, which
prevents our application from functioning properly.

If you know the new macro enabled file is from a reliable source, it’s better to
move the file to a trusted location, instead of changing the default Trust Center
settings to a less safe macro security setting. You should use a trusted location to
store your XL Guard workbook files to prevent the Trust Center from hindering the
normal behavior of our product or completely blocking it.

Add a trusted location:
Open Excel, Click File > Options.
1. Select Trust Center from the left side options.
2. Click Trust Center Settings on the right side.
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3. Select Trusted Locations from the left options.
4. Click Add new location on the right side.

5. Click Browse and find the folder you previously created for the Antivirus
    exclusions list, select the folder and then click Ok.
6. Optionally: Select “subfolders of this location are also trusted”.

Click OK again to accept the new settings.

You are now ready to enjoy XLforms applications.
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Install XL Guard
After purchasing the XL Guard Workgroup Edition on xlforms.com, you will
receive an .exe file to begin the download of your new application.

There is a possibility that when you first try to install the program, you will get a
pop-up that reads Windows protected your PC and see a button that says Don’t
run. This is something precautionary that Microsoft Defender does when it is
unfamiliar with a program. Click the "More info" on the pop-up and check if you
are familiar with the App name, and that the Publisher name is XLFORMS LLC. If
you see our information, continue with the installation as you normally would by
clicking on the newly added button that says Run Anyway.

See the below images

Once you have continued, you will receive a pop-up asking if you will allow the
program to make changes to your computer. Press Yes to continue.

If you have previously installed an older version of the XL Guard, you will be
asked if you would like to update the app with your current settings. If so, select
the Default option and click next. If you wish to change your settings, you may
select the Custom option, and you will be able to install the application as if for
the first time.

If you are installing the application for the first time, you will be asked to select
the location on your computer where you would like to store XL Guard. Select



Back To Top
_____________________________________________________________________________________

PROTECT YOUR DATA FROM PRYING EYES 11

your preferred file destination and continue, where you can choose to create a
desktop shortcut as well. This is highly recommended.

See the below images

After making these selections, click the Install button, and once the Setup
Wizard has completed the installation, click Finish to exit.

Getting Started
Now that the XL Guard Workgroup Edition has been successfully installed, open
the program via your preferred file destination or desktop shortcut if you elected
to create one.

This will open the XL Guard File Creator. The first time that you use the file
creator, you will be shown the End-User License Agreement. You must select I
Agree to be able to use the application.

After this, you will be shown a window with basic operating information about
your current version of the application, as well as this user manual. Any time you
wish to create a new protected XL Guard file, you will need to go to this window
and click Create New XL Guard File. Once you have done so, you will be able to
name your new protected workbook and save it in your preferred destination.

Now that you have created your workbook, open the new file, where you will
be prompted to log in.
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When you create new XL Guard workbook, the Default username and password
is as follows:

Username: admin

Password: password

THESE ARE CASE SENSITIVE

After logging in, you will be able to update your login information to be unique
to you. Bear in mind that once you have updated your login information, you
are responsible for keeping it recorded.

If you lose your username and/or password, XLforms will not be able to recover them.

After logging into the application, you will be brought to the This XL Guard tab, but lets
start by going through the administrator’s responsibilities.
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License and Activation
Before using any of the applications features, you must activate your user
license for the computer you will be using. You can do so either by clicking the
red Click Here on the This XL Guard tab or clicking the Activation & License
Management button.

You will be shown the below window, where you must select Log In and enter
the email and password that you used when first purchasing the application.
After doing so, you will be shown the number of licenses available on your
account, and click Activate to start using the application.

Please note that the programs’ basic features will function without an active
license, but in order to access any administrator rights, the license must be
installed on your device. If you get a new device and need to transfer your
license, simply click on the Activation & License Management button and log
out. The license will then be restored to your account and available for use on
another device.

Now that you’ve logged in with the default username and password, review the
Administrator tab and its functions before starting to use the application.
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Administrator Tab
Admin Password
XLforms highly suggests to change the
default administrator credentials and create
a unique username and password by
updating the credentials  in this tab,
especially if this application is to be shared
with others users. Once you have entered
your preferred login information, make sure
to save the application to ensure it is
successfully changed.

Activity Log
The other main feature of the Administrator
tab is the ability to review all user activity.
Any logins, user changes, saves, and other
updates to files within the workbook are recorded for the administrator’s
records.

Click Show Activity Log and you will be shown a screen that looks like such:
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Special User Access
Note: To use the special user access feature, you must add users to the User
Access List (UAL), via the Manage User Accounts tab.

The administrator tab is also where the owner of the workbook can go to assign

special access rights to trusted users or managers. By double clicking on the
corresponding box, the administrator can add users to the Worksheet
Management Group (WMG) and/or the User Management Group (UMG).

Please note that while the XL Guard can be used on devices without an active
license, administrator access and special user access rights are not available.

The administrator & users with special management rights (UMG & WMG) will
require a separate license for any device other than the one that the
application was originally registered with.
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Manage User Accounts Tab
User Access List (UAL)
The Manage User Accounts tab is accessible only
to the administrator and users who have been
added to the UMG.

This is where the usernames and passwords for all
users apart from the administrator are stored. Here
those in the UMG can create new logins for
employees, who later can choose to update their
password. In addition, if a user is unable to keep
track of their login information, the administrator or
managers can come to this tab to reset the user’s
account.

Note: Users are strongly advised not to use passwords which they use on other devices and
applications, as these passwords are all visible to the administrator at all times.

Manage Sheets Tab
The administrator and users in the WMG also have access to the Manage Sheets
tab. This is where the WMG can use XLforms proprietary Sheet Level Access
Control (SLAC) to add and remove standard users’ access to individual
worksheets.

Double-click on the box which corresponds to the sheet you want to
give/remove access to, and that user’s privileges will be updated.
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In addition to granting and revoking access
to individual sheets, here you can create,
arrange, duplicate, and delete new or
existing sheets. Users can also import
unprotected sheets from other Microsoft
Excel workbooks.

Click on the Sheets Manager button, and
you will be brought to the sheet manager
window.

Import Sheets, see dedicated section below.

New Sheet: Clicking this button will prompt you to name a new sheet, which will
then populate the list on the left-hand side of the window, and create the
corresponding tabs at the bottom of the screen. See the example below:

Rename: If you wish to rename a
particular sheet, select that sheet
from the list and click the
Rename button.

You will see the following
window, where you can update
your sheet as desired.
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Tab Color: If you want to give your new tabs distinctive
colors, select the corresponding sheet from the list and
click the Change Tab Color button.

Select the desired color from the new window (see
example to the right), then click OK. You will see that
the tab(s) at the bottom of the page have updated to
the selected color.

Other Features: In addition to the features described
above, you can easily duplicate or delete a
selected sheet by clicking the Copy Sheet or Delete
buttons as needed.

You may also change the arrangement of tabs by
using the arrow keys to the right of the list. Select the
sheet you wish to move, and press the up or down
arrow until the sheet is in the position you wish it to
be in.
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Import Sheets
Also present through the Manage Sheets button are the import option. If you
have sheets on existing workbooks that you would like to import and protect
using the XL Guard Workgroup Edition, click the Import button to open a new
window from which you can select a workbook and then the sheets to import.

Once the window has opened, click the Select Workbook button, where you will
be able to choose the desired Excel file (.xls, .xlsm, .xlsx, .xltm, etc.) from your file
explorer.

After you select your Excel file and click Open, the
available sheets within the workbook will appear
in the list on the left.

Once you can see the available sheets, you may
select whichever sheets you wish to add to your
protected workbook and click the Import Sheets
button, after which they will be added to your
workbook.
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If the workbook or sheet that you
are attempting to import is
password protected, you will be
prompted to enter the password
before the file can be imported.
This is to protect the data of other
Excel users.

Alternately, before attempting to
import, you can open the Excel
file that you wish to import, go to the Review tab, and press the Unprotect
Workbook or Unprotect Sheet button, enter the password to unprotect and then
save the file.

Workbooks with Protected VBA Code:

· If a workbook include password protected VBA Project module, you must
remove the password from the VBA Project before attempting to import and
then save the workbook.

· After selecting the desired sheets to import (from the unprotected VBA
Project workbook), any VBA code will be stripped from the imported sheets.

· Once you imported the desired worksheet/s you can password protected
the VBA project again.
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This XL Guard Tab
This tab will act as a homepage for both the administrator and standard users of
the application.

File Information
When first using the application, you will likely want to start inserting information
about this particular workbook. This information can include:

· A unique descriptive name for the file
· The name of the document creator
· A unique number or code for the file depending on your record-keeping

preferences
· The date that the workbook was created
· Additional information or notes regarding the intended purpose or use for

the particular workbook

The above image may vary from your version

The top right corner of XL Guard Tab will display the current application version,
the last time the workbook was saved, the last user to save the workbook, and
the user currently logged in.
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Once you have filled out the form to your satisfaction, you can scroll down to
insert additional information as needed, the Additional information section is
pictured below:

Change Logged-in User Password
While the administrator is able to change their password through their personally
assigned tab, all standard users must use the Change Password button found on
the This XL Guard tab. After clicking the button, users will be presented the
following window, where they can update their password as desired.

Note: Users are strongly advised not to use
passwords which they use on other devices
and applications, as these passwords are
all visible to the administrator at all times.
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Switch User
If you need to switch user without closing the application, click the Switch User
button. You will be prompted to save the file before logging out, this is highly
recommended.

Enter the desired username and password, then click on the login button!

Support
Thank you for choosing the XL Guard Workgroup Edition. To report
any bugs or request support for your paid application, please reach
out to support@XLforms.com.
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